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A

WARNING

Read and understand this manual and its safety instructions before using the
Form 4BL. Failure to do so can result in serious injury or death.

DISCLAIMER

Formlabs has made every effort to make these instructions as clear, complete, and correct
as possible. The information provided in this documentation contains general descriptions
and/or technical characteristics of the performance of the products contained herein. This
documentation is not intended as a substitute for and is not to be used for determining
suitability or reliability of these products for specific user applications. It is the duty of any
such user or integrator to perform the appropriate and complete risk analysis, evaluation, and
testing of the products with respect to the relevant specific application or use thereof. Neither
Formlabs nor any of its affiliates or subsidiaries shall be responsible or liable for misuse of the
information that is contained herein. Notify us if you have any suggestions for improvements
or amendments or have found errors in this publication.

Copyright © 2024 by Formlabs. All rights reserved.

support.formlabs.com

TRADEMARKS

All product names, logos, and brands are property of their respective owners. All company,
product, and service names used in this manual are for identification purposes only. Use of
these names, logos, or brands does not imply endorsement.

DOCUMENT REVISIONS

Date Version Document changes

Oct 2024 REV 01 Initial publication

Disclaimer |3
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1.2

1.21

Preface

Congratulations on purchasing the Form 4BL. On behalf of the Formlabs team, we thank you for
your purchase. The Form 4BL is a large-format Low Force Display (LFD)™ 3D printer. The Form
4BL fabricates fully-supported parts by converting a 3D object into 2D slices that can be cured
layer by layer with 405 nm light. This manual explains how to set up, use, and properly maintain
the Form 4BL, as well as provides design guidance for optimizing print results. The manual is
intended for anyone who is installing, operating, maintaining, or otherwise interacting with the
Form 4BL. Supervise young or inexperienced users to ensure enjoyable and safe operation.

Read and retain instructions

Read and understand this manual and its safety instructions before using the Form 4BL. Failure
to do so can result in serious injury or death. Keep all safety information and instructions for
future reference and provide them to subsequent users of the product.

Follow all the instructions. This will avoid fire, explosions, electric shocks, or other hazards that
may result in damage to property and/or severe or fatal injuries.

The Form 4BL shall only be used by persons who have fully read and understand the contents
of this manual. Ensure that each person who uses the Form 4BL has read these warnings and
instructions and follows them. Formlabs is not liable for cases of material damage or personal
injury caused by incorrect handling or non-compliance with the safety instructions. In such
cases, the warranty will be voided.

Obtaining documentation and information

Visit formlabs.com to:

» Access your Formlabs store (formlabs.com/store) and Dashboard accounts (formlabs.com/
dashboard).

« Find certified service providers in your region (formlabs.com/company/partners).

« Access the Terms of Service (formlabs.com/terms-of-service) and the Privacy Policy
(formlabs.com/privacy-policy).

Visit support.formlabs.com to:

« Access the latest version of all Formlabs product documentation.

» Contact Formlabs Support to request documentation, usage instructions, repair guides,
and technical information.

« Submit any comments or feedback regarding what is good and what can be improved.
Formlabs values comments from its users.

+ Request additional training.

Support and service

Retain a record of the original purchase to request warranty services. Service options depend

on the status of the specific product’s warranty. Include the serial name of the product when

contacting Formlabs Support or a certified service provider for product support.

Instead of a serial number, Formlabs products have a serial name, which is a unique identifier to

track the history of manufacturing, sales, and repair, and to distinguish usage when connected

to a network. The serial name is on the back panel of the machine in the format Form4L-

AdjectiveAnimal.



Service providers of Formlabs products also provide support and service. To the extent that
Formlabs or a certified service provider offers other or extended warranties, the terms of the
separate offer may apply. For products purchased from certified service providers, contact the
original service provider for assistance before contacting Formlabs Support.

For any support or service requests, including product information, technical assistance, or
assistance with instructions, contact Formlabs Support:

support.formlabs.com USA USA
Formlabs, Inc. Formlabs, Inc.
35 Medford St. 220 E Buffalo St.
Somerville, MA, USA, 02143 Milwaukee, WI, USA 53202
Germany Hungary
Formlabs GmbH Formlabs
Nalepastrasse 18 Andréssy 0t 9
12459 Berlin, Germany 1061 Budapest, Hungary
Japan Taiwan
1F Kitashinagawa 369 Building | No. 2828218829, Shizheng
3 Chome-6-9 Kitashinagawa North 2nd Rd, Xitun District
Shinagawa City Taichung City, Taiwan 407
Tokyo 140-0001, Japan

1.2.2 Warranty
This product is protected under warranty. Formlabs offers a warranty for all Formlabs branded
hardware. Unless otherwise expressly stated, the Terms of Service, including the Warranty,
constitute the entire agreement between you and Formlabs with respect to the Service and
any product you purchase from Formlabs and supersedes all prior or contemporaneous
communications, proposals, and agreements, whether electronic, oral, or written, between
you and Formlabs. Read the warranty for more details on the Formlabs warranty for your region:

us formlabs.com/terms-of-service

EU (EN) formlabs.com/eu/terms-of-service
EU (DE) formlabs.com/de/terms-of-service
EU (FR) formlabs.com/fr/terms-of-service
EU (ES) formlabs.com/es/terms-of-service
EU (IT) formlabs.com/it/terms-of-service

Preface 15
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2. Introduction

21 Intended use
The Form 4BL is a commercial, precision tool intended for use in the additive manufacture
of end-user supplied designs from photopolymer resin. The final performance characteristics
of cured photopolymer resin may vary according to your compliance with the instructions
for use, application, operating conditions, material combined with, end use, or other factors.

@ In some cases, the additive manufacturing process may inherently result in variable

performance characteristics between manufacturing runs or within a specific part.
Such variances may not be apparent and may result in unexpected defects in
additively fabricated parts.

NOTICE

You shall independently verify the suitability of additive manufacturing,

WARNING stereolithography (SLA), the Form 4BL, and any specific designs or materials
employed for the application and intended purpose before use. In no event shall
Formlabs be liable for any loss, death, or bodily injury that you suffer, or that you
cause to any third party, in connection with your use of Formlabs products. To the
fullest extent legally permitted Formlabs EXPRESSLY DISCLAIMS ANY IMPLIED OR
EXPLICIT WARRANTY OF FITNESS for a particular usage, the particular nature and

circumstances of said usage being unforeseen and unforeseeable to Formlabs.

A Formlabs provides tools and materials that may be used in many applications, but

ARNING makes no claims as to the safety or effectiveness of any specific devices made using
Formlabs products. Certain Formlabs products, such as those commonly known in the
industry as “biocompatible” materials, have been engineered to comply with relevant
industry standards. The specific standards and most relevant technical specifications
may be identified within the technical data sheets and have been tested according
to relevant testing protocols for those standards and specifications. Biocompatible
materials are a speciality product, developed for use by medical professionals, and
should be used in accordance with the instructions for use.

Do not modify. The Form 4BL is intended for use as-is. Modifying the machine without

ARNING explicit approval and directions from Formlabs will invalidate the warranty, and could

potentially ruin the machine and cause you bodily harm.
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Technical specifications

Printer
Technology
Print Engine

Minimum dimensions for
convenient access (W x D x H)
Printer dimensions (W x D x H)

Printer weight

Build volume (W x D x H)

Layer thickness (Axis resolution)

XY resolution

Optical power intensity
Optical wavelength
Resin cartridges

Resin dispensing system
Biocompatible materials

Supports

Operating environment

Operating temperature
Temperature control

Power requirements

Connectivity

Wi-Fi connectivity

Ethernet connectivity

Form 4BL
Masked Stereolithography (MSLA)
Low Force Display ™ (LFD)

88.9 x 116.8 x 81.3 cm
35.0x46.0x32.0in

66.4 x52.8x79.4 cm
261%20.8x313in

58.5 kg
129 1b

353 x 196 x 355 mm

13.9x77x14.0in

Parts taller than 305 mm (12 in) require that the resin tank be
removed with the build platform.

25-200 microns
0.001-0.008 in

46 micron pixel size with pretuned anti-aliasing
0.0018 in

16 mW/cm? delivered to the print plane
405 nm

2

Automated

Yes

Auto-generated
Light-touch removal

18-28 °C

64-82 °F

Low ambient humidity

Auto-heats resin to 25-45 °C (77-113 °F), depending on material
Direct resin heating

100-240 VAC
Maximum 9 A
50/60 Hz

Wi-Fi: 2.4, 5 GHz
Ethernet: 1000 Mbit
USB: 2.0

Protocol: IEEE 80211 b/g/n
Frequency: 2.4 GHz, 5 GHz
Supported security: WPA/WPA2

RJ-45 Ethernet (I0BASE-T/I00BASE-TX/1000BASE-T) LAN Port
Connect with a shielded Ethernet cable (not included): minimum
Catb, or Cat5e or Cat6 for I000BASE-T.

Introduction | 7
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2.31

USB connectivity USB C port with a USB C-A cable
Printer control Interactive touchscreen

Alerts Touchscreen alerts
SMS/email via Dashboard
Speaker for audio alerts

Camera Integrated camera
2592 x 1944 resolution (5 MP)

Print preparation PreForm desktop software

File type STL, OBJ, or 3MF

Product elements

\‘/—
L
(5]
o

Form 4BL

© Build platform: The aluminum base provides a surface for prints to attach to.

© Resin cartridges: Two containers that hold the resin before dispensing into the resin tank.
Shake resin cartridges periodically to keep resin well mixed.

© Resin tank: Resin is dispensed out of the resin cartridge into the resin tank. During a print,
light passes up through the bottom of the resin tank and cures resin onto the build platform
to form a printed part.

O Mixer: A mixer improves print consistency by clearing the build area and circulating the resin.

@ Door: The printer door, made of metal and a strong, orange-tinted material, blocks exposure
to the curing light and protects the resin from curing due to ambient light.
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@ Camera: An integrated camera for post-print photos, timelapses, and remote monitoring.
@ Mesh filter: Magnetically attaches to the side of the printer to prevent dust from reaching

the internal cooling fans.

@ Tank latches: Two tank latches secure the resin tank in place for printing.
© Touchscreen: The LCD capacitive touch user interface displays print information, settings,

and error messages.

@.Tool caddy: The tool caddy contains parallelism shims and four hex keys (2, 2.5, 3,and 5 mm)
to be used for printer maintenance. See 2.3.3 Included accessories for more information.

Rear ports

.

~

Included accessories

Ve

J

@ Power switch: For powering the printer
on and off.

® Power port: For connecting the printer to
mains power.

(® Optional fume exhaust port: A removable
air plug provides access to the print cavity
for active air handling.

@ USB and Ethernet ports: For connecting
the printer to a computer or network.

® Wi-Fi antenna port: For connecting the
external Wi-Fi antenna included with
the printer.

@ Power cable: Compatible with Form 4BL
generation printers.

@ Leveling disc: Slide the leveling disc
included around one of the leveling feet
and rotate to raise or lower the printer.

@®USB cable: USB C-to-A cable for
connecting the printer to a computer.

® Wi-Fi antenna: To be connected to the Wi-
Fi antenna port on the rear of the printer.

€ Parallelism shims: For adjusting and
aligning the build platform, if necessary.
Included in the tool caddy.

@ Hex keys: 2, 2.5, 3, and 5 mm right-angle
hex keys for printer maintenance and
repair. Included in the tool caddy.

Introduction | 9
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Form 4BL Finish Kit

© Rinse bucket: Fill the rinse bucket with solvent to the fill line before washing prints. The
rinse bucket includes a ground wire to prevent static discharge.

© Rinse basket: Place prints in the rinse basket, place the rinse basket into the rinse bucket,
and agitate to clean.

© Rinse bottle: Remove resin trapped in cavities and internal channels of prints. Use clean
solvent. Formlabs recommends isopropyl alcohol.

O Non-reactive nitrile gloves: Wear gloves when handling liquid resin, resin-coated surfaces,
or solvent. Wash skin with plenty of soap and water.

© Battery operated solvent pump: Fill and empty the rinse bucket.

@ Build platform jig: Stabilize the build platform for the secure removal of prints.

@ Drying tray: Place washed prints on the drying tray to drip dry.

© Flush cutters: Snip to separate prints from their supports. Cut with the flat side on the prints’
surface for minimal support marks.

© Plastic tank scraper: For inspecting and cleaning the resin tank interior. Do not press into
the tank film with the corners of the tool.

®. Metal scraper: Remove prints from the build platform. Do not use the scraper to clean the
resin tank interior.

@ Cleaning cloths: Disposable lint-free, non-woven microfiber cloths for cleaning the printer’s
optical components.

10
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Understanding the display

The Form 4BL’s display includes a touchscreen and speaker for audio notifications. The

touchscreen displays print information (job name, time remaining, layers printed), settings,

and error messages.

The touchscreen serves as the user interface for the printer. The audio notifications indicate

the printer’s state. Refer to messages on the printer’s touchscreen to understand the meaning

of the audio notifications. For detailed guidance and visual assistance, visit support.formlabs.
com.

« Tap the printer icon in the left sidebar to access the printer status screen. Information
about the inserted consumables, such as resin types, resin cartridge levels, and resin tank
temperature appear here.

+ Tap the collapsed menu icon in the left sidebar to access the Queue screen. A list of print
jobs that have been uploaded to the printer appears here.

« Tap the wrench icon in the left sidebar to access the Maintenance screen. Maintenance
procedures can be accessed here.

« Tap the gearicon in the left sidebar to access the Settings screen. Network connectivity,
printer management settings, and other options can be accessed here.

Introduction | 11
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WARNING
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CAUTION

©

CAUTION

)

NOTICE

Safety

Read and understand this manual and its safety instructions before using the Form
4BL. Failure to do so can result in serious injury or death.

Supervise young or inexperienced users to ensure enjoyable and safe operation.
The instructions contain warnings and safety information, as explained below:

DANGER indicates a hazard with a high level of risk which, if not avoided, will result in death
or serious injury.

WARNING indicates a hazard with a medium level of risk which, if not avoided, could result
in death or serious injury.

CAUTION indicates a hazard with a low level of risk which, if not avoided, could result in
minor or moderate injury.

NOTICE indicates information considered important, but not hazard-related.

ENVIRONMENTAL HAZARD: Uncured photopolymer resin is classified as hazardous to
aquatic life.

DANGER: Isopropy! alcohol is a flammable chemical.

Component and subsystem safety
General

UV light source: The backlight emits UV light. Do not look directly into the backlight
when it is powered on.

Lifting hazard: Due to its size and weight, do not move or reposition the Form 4BL
alone. If the machine needs to be moved, at least two individuals should use the lifting
straps provided with the Form 4BL.

Do not lift or reposition the Form 4BL:

+ By the door or any other movable part of the printer.

« When the printer is connected to a power source.

« When the printer is connected to an Ethernet or USB cable.

12



@ The Form 4BL requires an operating environment that is low in ambient humidity

Nomes and static electricity. Due to the sensitive nature of its components and the printing
mediums, system reliability and print quality may fluctuate if the ambient temperature
and moisture are outside the recommended ranges. Refer to section 4.1 Location and

environs for the recommended operating environs.
Sharp tools

312

f'} Cutting hazard: Using sharp tools on slippery surfaces (such as a resin-coated build
vy platform) can result in sudden movement. Orient sharp tools away from yourself,
especially when cutting or scraping.

The accessories include sharp tools such as: a removal tool, flush cutters, and a plastic
tank scraper.

Resin

Poison hazard: Never ingest resin in liquid or solid form. If swallowed, immediately call

P -

WARNING a poison center or medical professional. Contact Chemtrec at +1 800 424 9300 for

global 24-hour emergency assistance.

Refer to the safety data sheet (SDS) and local authorities for guidance on disposing

>

oo of resin and solvent. Liquid resin (whether pure liquid, dissolved in solvent, or partially
cured) may be classified as hazardous waste in your region and shall be disposed of

with care.

ENVIRONMENTAL HAZARD: Uncured photopolymer resin is classified as hazardous
to aquatic life.

©

Consult the safety data sheet (SDS) as the primary source of information to

©

NomeE understand safety and handling of Formlabs materials. Respect Formlabs resin like
any household chemical. Follow standard chemical safety procedures and Formlabs
resin handling instructions. In general, Formlabs resin is not approved for use with
food, drink, or medical applications on the human body. However, Formlabs resins
for biocompatible applications are biologically safe for specific types and lengths of
exposure to the human body. Refer to the safety data sheet (SDS) for each specific

resin as well as support.formlabs.com for more detail.

314 Radio interference
This equipment has been tested and found to comply with the limits for a Class A digital
device, pursuant to CFR Title 47, Part 15 of FCC Rules. These limits are designed to provide
reasonable protection against harmful interference when the equipment is operated in a
commercial environment. This equipment generates, uses, and can radiate radio frequency

Safety |13
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DANGER

NOTICE

316

O

NOTICE

3.2

A

WARNING

energy and, if not installed and used in accordance with the instruction manual, may cause
harmful interference to radio communications. Operation of this equipment in a residential
area is likely to cause harmful interference, in which case the user will be required to correct
the interference at their own expense.

Changes or modifications to this product not authorized by Formlabs could void the
electromagnetic compatibility (EMC) and wireless compliance and negate your authority to
operate the product.

This product has demonstrated EMC compliance under conditions that included the use
of compliant peripheral devices and shielded cables between system components. It is
important that you use compliant peripheral devices and shielded cables between system
components to reduce the possibility of causing interference to radios, televisions, and other
electronic devices.

Isopropyl alcohol (IPA)

Fire hazard: Isopropyl alcohol is a flammable chemical. Keep away from ignition
sources, including open flames, sparks or concentrated sources of heat.

Formlabs does not manufacture isopropyl alcohol. Consult the chemical manufacturer
or supplier for detailed safety information. Carefully follow the safety instructions
provided with the isopropyl alcohol that you purchase. Isopropyl alcohol can be
flammable, even explosive, and should be kept away from heat, fire, or sparks. Any
containers holding isopropyl alcohol should be kept closed or covered when not in
use. We also recommend that you wear protective gloves and have good ventilation
when working with isopropyl alcohol.

Tripropylene glycol monomethyl ether (TPM)

Formlabs does not manufacture tripropylene glycol monomethyl ether. Consult the
chemical manufacturer or supplier for detailed safety information. Carefully follow
the safety instructions provided with the tripropylene glycol monomethyl ether you
purchase. We also recommend that you wear protective gloves when working with
tripropylene glycol monomethyl ether.

Personal protective equipment (PPE)

Safe operation of the Form 4BL can be achieved by implementing the following equipment:
» Non-reactive nitrile gloves

. Safety glasses

Skin irritant: Resin and solvent may cause skin irritation or an allergic skin reaction.

Wear gloves when handling liquid resin, resin-coated surfaces, or solvent. Wash skin
with plenty of soap and water.

14
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CAUTION
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3.4

Risk of eye injury: Some methods of support removal may cause small pieces of
supports to break away. Beware of flying debris. Wear eye protection and gloves to
protect the skin and eyes.

Specifications of tools to be used
The Form 4BL shall only be used with supplied accessories and additional tools recommended
by Formlabs. Third-party accessories and materials may cause damage. Refer to sections
3.2 Personal protective equipment (PPE) and 6.1. Tools and supplies for more information.
Purchase additional supplies:
» Cotton swabs
For cleaning small resin spills.
+ Soap and water or glass cleaner
For cleaning the printer’s door, outer shells, and display.
- Isopropyl alcohol (IPA), 90% or higher
o Recommend washing solvent for rinsing prints.
o For cleaning the printer’s optical components and build platform.
o For cleaning the work surface and tools.
. Lithium grease for ball bearings
For lubricating the Z-axis screw.
. Low-fiber paper towels
o For cleaning the work surface and tools.
o For protecting sensitive components.
o For wiping residue grease, resin, or solvent.
- Non-abrasive microfiber cloth
For cleaning the printer’s door, outer shells, and display.
- Non-abrasive lint-free wipes
Disposable lint-free, non-woven microfiber cloths for cleaning the printer’s optical
components. Do not reuse cleaning wipes; dispose of after each use.
+ Rubber bulb air blower
For removing dust from the Light Processing Unit (LPU) texture.
- Tripropylene glycol monomethyl ether (TPM)
Alternative washing solvent to isopropyl alcohol for rinsing prints.

Sensitive components
The Form 4BL has multiple sensitive components that are vulnerable to permanent damage
if not periodically inspected and properly maintained. Using any tools, cleaning agents, or
methods not mentioned in this manual may result in permanent damage to these components.
Follow the maintenance instructions outlined in this manual and on support.formlabs.com
when servicing the following components or any other internal component of the machine.
For detailed guidance and visual assistance, visit support.formlabs.com.
- Backlight and Light Processing Unit (LPU) modules
These interchangeable assemblies contain the 405 nm LEDs and masking display that
control which areas of resin are exposed to light during each layer. Refer to section 8

Safety | 15
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DANGER

3.5.2

WARNING

O

NOTICE

Disassembly and repair for more information.

LPU release texture

The texture on the top of the LPU reduces forces on the printed parts, resin tank, and
printer between layers. Maintain a clean LPU to prevent print failures and damage to the
resin tank. Refer to section 6.6.5 Cleaning the LPU release texture for more information.
Platform lock

A lever that is part of the locking mechanism that secures the build platform. Contact
Formlabs Support or a certified service provider before adjusting the platform lock, as
improper adjustment can lead to damage to the machine.

Z-axis ball screw

The Z-axis ball screw is a threaded rod that controls the vertical motion of the build platform
mount. Keep the ball screw clean and well-lubricated so that the build platform mount can
move smoothly and accurately. To inspect and lubricate the ball screw, refer to section
6.5.5 Maintaining the Z-axis screw.

Emergency and exceptional situations
Formlabs has made every effort to provide updated safety data sheets (SDS) for every resin
product, in accordance with the latest government guidelines. Always consult the safety data

sh

eet (SDS) as the primary source of information to understand safety and handling of Formlabs

materials and required accessories.
3.5.1 Isopropyl alcohol (IPA)

Fire hazard: When handling isopropyl alcohol, always consult the safety data sheet
(SDS) from the isopropyl alcohol supplier as the primary source of information. Handle
isopropyl alcohol with gloves in a well-ventilated area. Keep away from heat, sparks,
and open flame. Isopropyl alcohol evaporates rapidly, so keep the rinse tub and
bottles closed whenever possible.

Resin

16

Poison hazard: Never ingest resin in liquid or solid form. If swallowed, immediately call
a poison center or medical professional. Contact Chemtrec at +1 800 424 9300 for
global 24-hour emergency assistance.

Promptly clean and inspect the printer after a resin spill to minimize any cosmetic or
functional damage to the printer. If you have experienced an accidental resin spill,
document the problem with photos and clean the printer as best as possible. Contact
Formlabs Support or a certified service provider as soon as possible.
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4.2

4.3

431

Preparation and setup

Location and environs
Prepare a space to install and operate the Form 4BL and house the necessary accessories
and consumables.
» Choose a location separate from any machinery or tooling that generates dust or sparks,
such as wood or metal working equipment.
« Ensure that the workspace meets the following requirements:
o Dry, indoor location
o Low ambient humidity
o Temperature of 18-28 °C (64-82 °F)
o Mains supply voltage fluctuations <10%
o Position the device so that it is easy to operate the power switch of the unit.
o Dedicate a power outlet and circuit to the device capable of delivering 9 A of current at
100-240 VAC, 50/60 Hz.
» Reserve the following minimum dimensions for the most convenient access:
o Form 4BL: 88.9 x 116.8 x 81.3 cm (35.0 x 46.0 x 32.0 in)
> Form 4BL Finish Kit: 55 x 85 x 90 cm (21.7 x 33.5 x 35.4 in)
o Additional space for other post-processing tools (e.g., Form Wash L, Form Cure L, or
Formlabs-approved third-party devices)
« Purchase additional supplies:
o Isopropyl alcohol (90% or higher) and/or tripropylene glycol monomethyl ether
o Low-fiber paper towels
o Non-abrasive microfiber cloth
o Non-reactive nitrile gloves
o Disposable non-abrasive lint-free wipes
o Safety glasses

Networking

For uploading prints to the Form 4BL and remotely monitoring the printer, ensure that the Form
4BL maintains a constant connection to a secure network. Refer to section 4.6 Connecting
the printer to a network for more information. For detailed guidance and visual assistance,
visit support.formlabs.com.

Unboxing the printer

Prior to unboxing the printer, prepare a suitable workspace according to section 4.1 Location
and environs. For detailed guidance and visual assistance, visit support.formlabs.com.
Form 4BL package

The standard Form 4BL package ships with multiple boxes: the Form 4BL printer, Form 4BL
Finish Kit, resin tank, resin cartridge, and build platform. Additional resin cartridges and
accessory boxes ship separately from the Form 4BL's packaging.

Preparation and setup 117



Resin Build

Printer Finish Kit cartridge Resin tank platform Mixer
Shipping 83 x 68 x 52 x 41 % 89x102x | 656 x455 | 54x28x 39 x 151 %
dimensions 108 cm 17 cm 28.6 cm x12 cm 14 cm 4.4 cm

(327x26.0 | (205x161x  (3.5x40x  (2568x179 | (21.3xN.0x (154 x59x

x42.51n) 6.7 in) 1.3in) x 47 in) 5.51n) 17in)
Shipping 75 kg 4 kg 1.5 kg 3.8kg 3.3 kg 0.5 kg
weight (168.8 Ib) (8.8 1b) (3.31b) (8.5 1b) (7.3 1b) (11 1b)

43.2 Unboxing the Form 4BL

The custom packaging the Form 4BL arrives

in is specially designed to protect the machine

during shipping. During unboxing, inspect

the product for any damage or missing items.

In the case of damage or missing items,

contact Formlabs Support or a certified

service provider.

To unbox the printer:

1. Position the Form 4BL's packaging near the
designated location, leaving enough room

for two people to comfortably maneuver
throughout the area. Stand the Form 4BL’s
packaging upright to ensure it is level.

2. Cut the shipping straps securing the
printer box.

3. Lift the outer box off the printer.

4. Remove the power cable and accessories

box from on top of the printer.

5. Remove the two foam inserts from the top
of the printer.

6. With two people on opposite sides of the
printer, use the provided handles on the

lifting straps to lift the printer out of the
lower box. Q
7. Carefully move the printer onto
its workspace. &
4
If you need to readjust the Form e

4BL, use the lifting straps to pick the
CAUTION
machine back up. Do not pick up the

Form 4BL without the lifting straps.
8. Remove the lifting straps from under the printer.
9. Remove any additional wrapping and packaging from outside of the printer before

connecting the machine to power.
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Save the Form 4BL’s packaging including any inserts for transporting the machine.
Original packaging is required for warranty service and designed to be kept and
reused for transportation or shipping.

Serial name

The serial name is a unique identifier used to track the history of manufacturing, sales, and
repair. The serial name for the Form 4BL is located on a sticker next to the A/C input on the
back panel in the format Form4L-AdjectiveAnimal. The serial name is also available on the
printer’s touchscreen.

To access the serial name the printer’s touchscreen:

1. Tap the printer icon on the Home screen. The printer status screen appears.

2. The serial name is listed in the top-left corner.

Installing the printer

After selecting a location for the Form 4BL,
connect the power supply and turn on the
printer. Depending on your internet setup,
you may need to connect an Ethernet cable
to establish an internet connection on the
printer.

Connecting the cables

Connect the power cable to the printer and
to the power supply. Files can be uploaded
via Wi-Fi, Ethernet, or USB. For USB,
connect the printer to a nearby computer.

For Ethernet, connect the printer to your
LAN. Refer to section 4.6. Connecting the
printer to a network for more information.

Installing the Wi-Fi antenna

Install the Wi-Fi antenna to connect the printer to a wireless network.

To install the Wi-Fi antenna, screw the Wi-Fi antenna onto the jack on the back of the machine,

next to the USB and Ethernet ports.

Turning on the printer

To turn on the printer:

1. Plugtheincluded power cable into the power port on the back of the machine and connect
the power cable to a power outlet.

2. Flip the power switch to the ON (l) position.

3. The printer initiates.

To put the printer into sleep mode or turn off completely, refer to section 5.6.5 Turning off

the printer.

Connecting the printer to a network
Connect the Form 4BL to a secure network via Wi-Fi, Ethernet, or USB, providing it internet
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access for remote printing, remote troubleshooting, and sending diagnostic logs. The Form
4BL can connect directly to a computer with a USB cable. For detailed guidance and visual
assistance, visit support.formlabs.com.
For remote uploading and monitoring, the Form 4BL supports both wired (Ethernet) and
wireless (Wi-Fi) connections. Connect PreForm print preparation software to the same local-
area network (LAN) as the printer in order to send a print job.
For a Windows operating system, after installing PreForm, check to ensure that Bonjour is
properly installed. Bonjour is third-party software that is required to connect over Wi-Fi or
Ethernet. Visit support.apple.com for assistance with Bonjour. The USB connection can still
be used while the Form 4BL is connected to a LAN.
When the Form 4BL is connected to a LAN, its current status and print progress can
be monitored with Dashboard: formlabs.com/dashboard.
Connecting with Wi-Fi
The Form 4BL’s built-in Wi-Fi (IEEE 802.11 b/g/n) supports WPA/WPA2 security. Use the printer’s
touchscreen to configure a wireless network connection.
To connect with Wi-Fi:
1. Tap the gear icon on the Home screen. The Settings screen appears.
2. Tap Connectivity > Wi-Fi. The Wi-Fi screen appears.
3. Toggle Use Wi-Fi to ON. The toggle turns blue.
4. Tap the desired wireless network.
5. If prompted, enter your network password and tap the checkmark to confirm.
Connecting with Ethernet
The rear of the unit is equipped with a RJ-45 Ethernet (I0BASE-T/100BASE-TX/1000BASE-T)
1000 Mbit LAN Port. Use a shielded Ethernet cable (not included): minimum Cat5, or Cat5e
or Cat6 for I000BASE-T.
To connect with Ethernet:
1. Plug one end of the Ethernet cable into the Ethernet port on the back of the machine
2. Connect the other end of the Ethernet cable to your LAN.
Connecting with a manual IP configuration
When connected to an active Ethernet connection or available Wi-Fi network, the Form 4BL
can be configured with a static IP address. Use the printer’s touchscreen to configure a manual
IP connection.
To connect with Wi-Fi or Ethernet using a manual IP configuration:
1. With an established Ethernet or available Wi-Fi connection, tap the gear icon on the Home
screen. The Settings screen appears.
2. Tap Connectivity. The Connectivity screen appears.
o For Wi-Finetworks, tap Wi-Fi, then the desired wireless network. The Wi-Fi screen appears.
o For Ethernet connections, tap Ethernet. The Manual IP Settings screen appears.
3. Toggle Use Manual IP to ON. The toggle turns blue.
4. Enter the appropriate IP Address, Subnet Mask, Default Gateway, and Name Server.
Connecting with USB
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Use a USB cable to connect a computer directly to the printer.

To connect with USB:

1. Plug one end of the USB cable into the USB-C port on the back of the machine.
2. Connect the other end of the USB cable to a computer’s USB port.

Leveling the printer
The Form 4BL must be completely level before printing can begin. If prompted, use the leveling
disc to raise or lower each foot of the printer.

It is important that the printer sits level so resin does not overflow from the resin tank
during printing. All four leveling feet must rest on a solid surface to ensure optimal
print accuracy.

To level the printer:

1. Connect the printer to power. If necessary, the printer’s touchscreen prompts use of the
leveling disc.
o The initial printer setup includes the leveling procedure.

2. Follow the on-screen instructions to adjust the feet under the printer.

3. Insert the round leveling disc under the designated corner. Push until the leveling disc
clicks onto the leveling foot.

4. Rotate the leveling disc clockwise to raise and counter-clockwise to lower the height of
the printer.
o The printer ships with each leveling foot fully retracted. The height of the feet can only

be raised during the initial printer setup.
5. Adjust the feet until the printer’s touchscreen indicates the printer is level.

Inserting the resin tank and mixer

Resin is dispensed out of the resin cartridge into the resin tank. During a print, light shines
upward through the bottom of the resin tank and cures resin onto the build platform to form
a printed part. A mixer improves print consistency by clearing the build area and circulating
the resin.

Skin irritant: Resin and solvent may cause skin irritation or an allergic skin reaction.

Wear gloves when handling liquid resin, resin-coated surfaces, or solvent. Wash skin
with plenty of soap and water.
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Spill hazard: Resin may spill over the tank walls if the resin tank tilts more than 5-10
degrees. Hold the resin tank level with two hands. To inspect and clean the resin
tank’s underside, empty the resin tank and/or take care to avoid spilling resin outside
the resin tank.

Inserting the resin tank
To insert the resin tank:

1.

Inserting the mixer
To insert the mixer:

1

2.

. With the tank spout facing right, rest the

. Push the resin tank forward until the resin

. Insert the mixer into the mixer mount and

. Lock the mixer into place by closing

Open the printer door.

2. Remove all packaging from the resin tank before inserting it into the printer.
3.
4. Lift the resin tank with one hand on each side.

Remove the resin tank lid and set it aside.

Avoid contaminating the resin tank’s underside with fingerprints or liquid resin.

front edge of the resin tank on the rails in
the printer.

tank reaches the back of the machine. The
printer detects its insertion and displays a
message on the touchscreen.

Rotate the latches at the front corners of
the resin tank upwards to secure the tank
in place.

Open the printer door.
Orient the mixer with its flat body facing
away from you. Open the latch on the mixer.

place the flat body into the tank.

the latch.

Inserting the build platform
The build platform is the surface onto which parts are printed. It is secured in place on the
build platform mount during a print with the platform lock.

To insert the build platform:

1

2.

. Slide the build platform latch to the right to

Slide the build platform latch to the left.
Align the build platform with the build
platform mount and push into place. The
printer detects its insertion and displays a
message on the touchscreen.

secure the build platform.
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410 Inserting the resin cartridges

Resin cartridges hold liquid resin before it is dispensed into the resin tank. Given the build

volume and the size of the resin tank, Form 4L generation printers use two resin cartridges

at once.

To insert the resin cartridges:

1. Shake the resin cartridges before each print to ensure the resin is mixed thoroughly. Shake
each resin cartridge approximately every two weeks during storage to keep resin well
mixed for the best print quality.

@ Spill hazard: Do not remove the flexible, rubber bite valves at the bottom of the resin

cartridge. These bite valves control the release of the resin. Removing the bite valves
allows resin to continuously flow and causes extreme damage to the printer. This
damage is not covered by the warranty.

NOTICE

2. Align the resin cartridge with one of the
two cartridge slots on the right side of
the printer.

3. Place the resin cartridge into the slot.
The resin cartridge fits into the slot in
one orientation. The printer detects its
insertion and displays a message on
the touchscreen.

4. Press the vent cap open, so that the resin
tank fills correctly.

5. Place a second resin cartridge, with the
same resin type and version, into the
other slot.

a1 Installing the Form 4BL Finish Kit
The Form 4BL comes with a finishing kit that includes a variety of post-processing tools. After
printing, use the tools to remove prints from the build platform, wash prints in solvent, and
remove supports.
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Installing the rinse bucket

Connect the rinse bucket ground wire to a grounded piece of metal. If you store
solvent in a metal container, electrically connect it to the grounded rinse bucket.

To fill the rinse bucket with solvent:

1. Place the pump intake into the solvent container.

2. Securely place the flexible pump hose into the rinse bucket.

3. Press and hold the pump switch to pump solvent into the rinse bucket. The wash bucket
holds up to 371L (9.8 gal) of solvent.

Ensure that you have sufficient solvent (e.g., isopropyl alcohol, tripropylene glycol monomethy!

ether, or Formlabs Resin Washing Solution) to wash your prints. For more information about

solvent handling, visit support.formlabs.com.

Installing the build platform jig

-

- J

The build platform jig is designed to stabilize the build platform for the secure removal of
prints. Secure the build platform jig to the edge of your work surface by tightening the jig screw

clamps underneath the work surface. The build platform jig can also be secured to the work
surface using the two screw holes on the front of the jig. Ensure that there is enough space
in front of the jig for the build platform.
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Place the posts on the top of the build platform into the holes on the top of the jig to secure
it in place while removing your printed parts.

Resin-coated surfaces can be slippery. Point sharp tools away from yourself when separating
printed parts from the build platform.

Transporting the printer
Refer to the section 4.3 Form 4BL package for product weight and dimensions. Keep the
packaging for transportation or shipping. For detailed guidance and visual assistance, visit
support.formlabs.com.
The printer’s complete packaging kit consists of:

Lower box, cardboard (1x) )
. Outer box, cardboard (1x)
. Internal edge supports, cardboard (4x)

. External edge protector, cardboard (8x)
. Lower foam insert, foam (2x)
. Upper foam insert, foam (2x)
Lifting straps (2x)
. Pallet, wood (1X)
. Upper tray, cardboard (1x)
10. Accessories box, cardboard (1x)

O 00 N O U1 W N T

Preparing the printer for transportation

To prepare the printer:

1. Always remove the build platform, resin tank, mixer, and resin cartridges before moving or
packaging the printer.

2. Wipe residual resin from the build platform and store the platform away from sunlight.

Do not ship the printer with any resin inside. Resin left inside the machine can leak
during transit, which may result in additional fees or void the warranty.

Do not ship the printer with the resin tank, resin cartridge, or build platform inserted
into the printer. Consumables left inside the machine can become loose during transit
and damage sensitive components, which may result in additional fees or void the
warranty.

3. Store the resin tank with its lid in place.
4. Store the resin cartridge with the vent cap pressed closed and the valve cover installed.

When shipping a printer to Formlabs or a certified service provider for replacement or
repair, the build platform, resin tank, resin cartridge, power and USB cables, and other
accessories should not be shipped and will not be returned after service. Original
packaging is required for warranty service. Contact Formlabs Support or a certified
service provider for unique guidance on shipping requirements.

Packaging the printer
To package the printer:
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If the printer’s outer box has been collapsed, start by reassembling and securely taping
the box.

. Tilt one side of the printer up and slide a lifting strap underneath, running front to back under

the printer. Repeat with a second sling under the other side of the printer.

. Place the two lower foam inserts into the lower box.
. Use the provided handles on the lifting straps to lift the printer onto the lower foam inserts.

Lifting hazard: The Form 4BL is a heavy object. A two person lift is required to
prevent injury and avoid damage to the machine.

. Place one internal edge support vertically in each corner of the lower box.
. Place the two upper foam inserts on the top edges of the printer.

Place the upper tray and accessories box in the cutouts in the upper foam inserts.

. Lower the outer box onto the printer.
. Seal each edge of the opening with adhesive packing tape.

10. Place the eight external edge protectors on the top of the outer box, two on each edge,

for your carrier to strap the box to a pallet.
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Printing

Operational environment
The operating temperature for the Form 4BL is 18—-28 °C (64—-82 °F), with low ambient humidity.
For optimal printing, do not exceed this range.

Designing for SLA

A successful 3D print starts with a well-designed model. Follow these best practices to optimize
designs and reduce print failures. For detailed guidance and visual assistance, visit support.
formlabs.com.

Printing specifications

Parameter Unit

Build volume (W x D x H) 353 x196 x 355 mm
13.9x77x14.0in
Parts taller than 305 mm (12 in) require that the
resin tank be removed with the build platform.

Layer thickness 25-200 microns
0.001-0.008 in

Feature design guidelines
Consult Design specifications for 3D models (Form 4L generation) for a list of the minimum
feature requirements you can expect from Form 4L generation printers.

Setting up a print

Form 4BL print jobs can be set up using PreForm, Formlabs’ print preparation software. To start,
open OBJ, STL, or 3MF files in PreForm, orient and layout multiple models into a complete
build, then upload the print job to the printer. For detailed guidance and visual assistance,
visit support.formlabs.com.

Downloading or updating PreForm

Visit the PreForm product webpage to download the latest version: formlabs.com/software.
Learn how to use PreForm from the tutorials available in the software. Click Help > Show
Onboarding Tutorial from PreForm’s menu bar.

Preparing the file for printing

Use PreForm software to process STL, OBJ, or 3MF files. Prepare, save, and upload FORM
files to the printer.

Adding a model

Import multiple part files into PreForm to print multiple parts on a single build platform.

To add a model:

1. In the menu bar, click File > Open. The Open File window opens.

2. Select at least one file.

3. Click Open. The selected models appear in PreForm.

Orienting a model

Orienting a model within the build volume consists of two components: moving a model and
rotating a model. Position a model to prevent suction cups and reduce minima.
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To move a model to a different location:
1. Select the model in PreForm. Manipulators are overlaid on the model.
2. To move:
o Click-and-drag the Move manipulator to a new location on the build platform.
o Click-and-drag the selected model to a new location on the build platform.
To rotate a model along the X-, Y-, and Z-axes:
1. Select the model in PreForm. Manipulators are overlaid on the model.
2. Click Orientation. A dialogue box opens.
3. To rotate:
o Click-and-drag along the central manipulator to spin the model freely.
o Click-and-drag on a ring to move the model along that axis.
o Enter a specific angle into an axis field.
o Click on an axis arrow.
o Hover the pointer over an axis field and use the scroll wheel.
Supporting a model
Supports reinforce overhangs and other delicate features for maximum printability. They
should be removed after the print is complete. Supports can be auto-generated en masse or
individually placed by hand.
To auto-generate supports:
1. Select the model in PreForm.
2. Click Supports. A dialog box opens.
3. Click Auto-Generate All. Supports are added to all models on the build platform.
To manually add and edit supports:
1. Select the model in PreForm. Manipulators are overlaid on the model.
2. Click Supports. A dialog box opens.
3. Click Edit.... The model turns gray and supports are shown as white touchpoints.
4. Click on the under-supported areas in red to add a support. White touchpoints appear
where clicked.
5. Click Apply. Supports are regenerated and remaining under-supported areas are
highlighted in red.
6. Repeat until the model is fully supported.
Uploading a print
After orienting and supporting your model(s), and saving your FORM file, upload your print job
to the printer. Both the printer and the computer running PreForm must be connected via USB
or on the same network in order to upload a print job. Refer to section 4.6 Connecting the
printer to a network for more information. Once transferred, print jobs must be confirmed on
the printer’s touchscreen to begin. Refer to section 5.4.2 Starting a print for more information.
To upload a print job from PreForm to the printer:
1. Click the orange printer icon on the Home screen. The Print window opens.
2. Click the Select Printer arrow to select a printer. The Printer List window opens.
3. Click the name of a printer you wish to select. The Printer Details window opens.
o If the printer does not automatically appear in the Printer List, click Add to manually
enter the printer’s IP address.
4. Click Select. The Job Setup window opens.
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5. Click Apply. The selected printer appears in the Job Info dialog box.

6. Enter or update the Job Name.

7. Click Print Now to start the printimmediately if the printer is ready or Add to Queue to add
the print to the printer's queue. Once the progress bar fills and the Print window closes,
the upload is complete.

Preparing the printer for printing

Before a print job can begin, the Form 4BL must be set up to match the correct material

settings. Insert the resin tank, build platform, and resin cartridge. Confirm the print job on

the printer’s touchscreen and wait for the print chamber inside the Form 4BL to preheat. For

detailed guidance and visual assistance, visit support.formlabs.com.

Automatic consumables checks

The Form 4BL checks the following before each print:

« Accessories: Sensors check for the proper installation of the build platform, resin tank,
and resin cartridges.

» Temperature: The printer heats the resin to its optimal temperature before starting the print.

« Resin: Resin flows from the resin cartridges into the resin tank when the cartridge dispense
arm squeezes the bite valve of each resin cartridge open. The Form 4BL regulates the
volume of resin in the resin tank through a sensor called the LevelSense, which is located
above the rear left-hand corner of the resin tank. The printer begins to fill the resin tank
once a print starts and maintains the level of resin in the resin tank during the print. Printing
begins automatically when LevelSense detects the proper amount of resin in the resin tank.

- Debris: The mixer and sensors check for debris left on the build platform.

Readying your printer to start a print

Before the printer can start a print, confirm that the build platform is clean and ready to use

and that the mixer is secured in place. To ready your printer to start a print:

1. On the touchscreen, tap the printer icon on the sidebar.

2. Tap the check mark next to the Build Platform and Tank status items to confirm that they
are ready to be used.

3. The status in the top bar changes to Ready.

QO Build Platform

Confirm platform is clean

Build Platform
Present

O Tank
Permanent Crown C2
Confirm mixer is locked

Tank
Permanent Crown C2
Present

Starting a print

Once a printjob is uploaded to the Form 4BL, the printer’s touchscreen displays the next print
job in the queue. To start the print, tap Print on the printer’s touchscreen.

If the file is not the next print job in the queue, tap the collapsed menu icon from Home to
access the Queue screen.
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To start a print on the printer’s touchscreen:

1. Tap the print job on the Home screen, or from Queue. The print job screen appears.

2. Tap Print to confirm. A new screen appears.

3. Follow the prompts on the touchscreen to check the resin tank and cartridge are inserted
correctly, then tap Confirm. The print starts once the resin in the resin tank has reached
its optimal temperature.

Stopping a print

To stop a print in progress, tap Pause > Abort on the printer’s touchscreen.

Moving parts. Do not open the printer door until the printer’s touchscreen indicates
the print is complete. Moving parts present crushing and tangling hazards.

Finishing and post-processing a print

Finishing and post-processing includes all steps after printing. Bring a 3D model from a digital
file to a functional print with the following steps. For detailed guidance and visual assistance,
visit support.formlabs.com.

Skin irritant: Resin and solvent may cause skin irritation or an allergic skin reaction.
Wear gloves when handling liquid resin, resin-coated surfaces, or solvent. Wash skin
with plenty of soap and water.

To finish and post-process a print:

1. Put on a new, clean pair of nitrile gloves.

2. When the print is complete, open the printer door and slide the build platform latch to
the left.

3. Use both hands to grip the handles and remove the build platform from the printer.

4. Close the printer door.

5. Wash the print in the Form Wash, Form Wash (2nd Generation), Form Wash L, Form 4BL
Finish Kit, or a Formlabs-approved third-party large-format ultrasonic cleaner. Formlabs
products, such as the Form Wash L, can be used with either isopropyl alcohol or tripropylene
glycol monomethyl ether as a washing solvent.

Fire hazard: Isopropyl alcohol is a flammable chemical. Keep away from ignition
sources, including open flames, sparks, or concentrated sources of heat.

6. Remove the solvent from the print.
o If your solvent evaporates readily (e.g., isopropy! alcohol), allow at least 30 minutes for
the solvent to fully evaporate after washing.
o If your solvent does not evaporate readily (e.g., tripropylene glycol monomethyl! ether),
wash the prints with water to remove excess solvent.
7. Dry your prints. Ensure all prints are fully dry and free of excess solvent, resin, and other
liquids before post-curing.
8. Post-cure your print with the Form Cure, Form Cure L, or a Formlabs-approved third-party
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large-format SLA post-curing unit to achieve a part’s full mechanical properties.
9. Post-process your print by removing supports, sanding down blemishes, and adding paint.

Managing the printer

During and between prints, you can track your printer’'s usage, manage print jobs, and prepare
for future print jobs. For detailed guidance and visual assistance, visit support.formlabs.com.
Connecting the printer to Dashboard

Dashboard (formlabs.com/dashboard) allows individuals and teams to remotely monitor
Formlabs printers, track material usage, and explore past and future Formlabs purchases.
Register the Form 4BL to Dashboard through the printer’s touchscreen. Once the printer is
registered to Dashboard and Dashboard logging is enabled on the printer, the Form 4BL
sends data to Dashboard as long as the printer’'s Wi-Fi or Ethernet connections are able to
access the internet.

Starting an uploaded print

To start an uploaded print job on the printer’s touchscreen:

1. Confirm the resin tank, build platform, and resin cartridge have been inserted into the printer.
2. Tap the print job from Queue.

Refer to section 5.4.2 Starting a print for more information.

Deleting an uploaded print

To delete an uploaded print job on the printer’s touchscreen:

1. Tap the print job from Queue.

2. Tap Delete. If prompted, tap Delete again to confirm.

Changing resin types between prints

When changing resin types, always change both the resin tank and resin cartridge. Remove the
resin cartridge before removing the resin tank to prevent the bite valves from dripping resin
into the printer cavity. Refer to sections 6.7.3 Replacing the resin tank and 6.6.3 Replacing
the resin cartridge for more information.

Checking and maintaining the resin temperature

The Form 4BL heats resin to a set temperature before starting a print. View the resin’s current
temperature on the printer’s touchscreen.

The resin is heated by resistive heaters located beneath the resin tank. The Form 4BL
automatically preheats and maintains a consistent print chamber temperature before and
between prints.

Turning off the printer

The Form 4BL is designed to be left powered on when not in use. Depending on your printer’s
firmware version, there is an option, accessible through the printer’s touchscreen, that places
the printer into sleep mode immediately or after a set period of inactivity.

Tap the printer’s touchscreen, insert or remove consumables, or otherwise interact with the
printer to wake it from sleep mode. For detailed guidance and visual assistance, visit support.
formlabs.com.

Turn off the machine completely when moving or storing the printer, and to conserve power.
To turn off the printer completely:

1. Press the power switch on the back of the machine, next to the power cord.

2. The printer turns off.
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Maintenance

Formlabs provides instructions to advise in installing, operating, and maintaining the machine.
It shall only be maintained by a qualified and trained person. Unauthorized disassembly or
repair procedures may damage the machine.

There are two groups of maintenance procedures: regular, which should be done after every
print, and intermittent maintenance, which only needs to be done occasionally. Please keep a
log detailing when each intermittent maintenance procedure was last performed. For detailed
guidance and visual assistance, visit support.formlabs.com.

« Formlabs provides instructions to advise skilled and unskilled persons in installing,
operating, and maintaining the Form 4BL. The Form 4BL shall only be maintained by
a qualified and trained person.

« Do not open the machine and/or investigate internal components unless under the
guidance of Formlabs or a certified service provider. Contact Formlabs Support or a
certified service provider for any additional guidance.

« Unauthorized disassembly or repair procedures may damage the machine and void
the warranty.

« Wear personal protective equipment (PPE) when performing maintenance tasks.
Use tools only as described.

« Disconnect the machine from its power source before maintenance. Moving parts
present crushing and tangling hazards.

Tools and supplies
Only use tools, chemicals, or procedures to maintain the Form 4BL that are outlined in this
manual, by prompts on the printer’s touchscreen, and support.formlabs.com.
Do not use any tools, chemicals, or unapproved procedures with the Form 4BL unless
otherwise instructed to do so by Formlabs Support or a certified service provider.
« Cleaning sheet
For cleaning the interior of the resin tank.
» Cotton swabs
For cleaning small resin spills.
» General purpose cleaner (e.g., glass cleaner) and/or soapy water
For cleaning the printer’s door, outer shells, and display.
- Isopropyl alcohol (IPA), 90% or higher
o For cleaning the printer’s optical components and build platform.
o For cleaning the work surface and tools.
- Lithium grease for ball bearings
For lubricating the Z-axis screw.
. Low-fiber paper towels
o For cleaning the work surface and tools.
> For protecting sensitive components.
o For wiping residue grease, resin, or solvent.
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6.2

6.21

6.2.2

6.2.3

6.3

A

WARNING

- Non-abrasive microfiber cloth

For cleaning the printer’s door, outer shells, and display.
- Disposable non-abrasive lint-free wipes

For cleaning the printer’s optical components.
+ Rubber bulb air blower

For removing dust from the Light Processing Unit (LPU).
- Plastic tank scraper

For inspecting and cleaning the interior of the resin tank.

Inspecting and maintaining the printer

Inspect and maintain your printer and consumables to ensure that your printer continues to
function properly and produce high print quality. For detailed guidance and visual assistance,

visit support.formlabs.com.
Before each use

Inspect Refer to

Installation environment Operational environment
Build platform Cleaning the build platform
Resin cartridge bite valves Inspecting the bite valves
Resin resin tank interior Inspecting the resin tank

Before switching resin types

Inspect Refer to

Mixer Cleaning the mixer

Periodic maintenance

Inspect Refer to

Door Inspecting the door

Display Inspecting the display

Drip catcher Inspecting the drip catcher
Shells Inspecting the shells

Z-axis screw Maintaining the Z-axis screw

Tasks between uses

Section
41
6.31
6.3.2
6.71

Section

6.41

Section
6.5.1
6.5.2
6.5.3
6.5.4
6.5.5

Perform the following maintenance tasks between each print. For detailed guidance and visual

assistance, visit support.formlabs.com.

Skin irritant: Resin and solvent may cause skin irritation or an allergic skin reaction.

Wear gloves when handling liquid resin, resin-coated surfaces, or solvent. Wash skin

with plenty of soap and water.
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6.31

6.3.2

6.3.3

6.4

6.4.1

6.5

6.5.1

Cleaning the build platform

The build platform is the aluminum base that provides a surface for prints to attach to. Over time,
the build platform develops scratches from part removal, which can assist with print adherence.
Avoid exposing a resin-covered build platform to light directly after a print completes. Liquid
resin cures in ambient light, and resin left on the surface of a build platform renders it unusable.
Required supplies

» Isopropyl alcohol

- Low-fiber paper towels

« Non-reactive nitrile gloves

When switching to a different resin type between prints or storing the build platform for future
use, clean the surface and edges of the build platform with isopropyl alcohol and low-fiber
paper towels. If you are starting a new print immediately using the same resin type, there is
no need to remove liquid resin.

Inspecting the bite valve

The bite valve is located on the underside of each resin cartridge. This flexible seal regulates
resin dispensing. Resin flows out of the opening in the center of the bite valve when the
cartridge dispense arm squeezes the bite valve open. When switching to a different resin
cartridge, inspect the bite valve for any cured resin or damage.

Inspecting the resin tank interior

Refer to section 6.7 Inspecting the resin tank.

Tasks before switching resin types

Perform the following maintenance tasks whenever you switch resin types. For detailed

guidance and visual assistance, visit support.formlabs.com.

Cleaning the mixer

The mixer improves print consistency by clearing the build area and circulating the resin.

If you are running multiple prints with the same resin type, you do not need to clean the

mixer between prints. If you are switching resin types, clean the mixer between uses to

prevent contamination.

To clean the mixer:

1. Unlatch and remove the mixer from the printer.

2. Clean the mixer with a solvent such as IPA or TPM. Either:

a. Wipe the mixer with a clean paper towel wetted with solvent.
b. Clean the mixer with the Form Wash L or other automated cleaning unit.

3. Allow the mixer to dry fully before reinserting it into the printer. If you cleaned the mixer
with a solvent that does not readily evaporate, such as TPM, you may need to manually
dry the mixer.

If the mixer is visibly damaged, is leaving debris in the resin tank, or is causing the resin in the

resin tank to become discolored, replace the mixer.

Periodic maintenance

Perform the following maintenance tasks periodically or as needed. For detailed guidance
and visual assistance, visit support.formlabs.com.

Inspecting the door
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6.5.2

6.5.3

A

WARNING

A

WARNING

6.5.4

6.5.5

WARNING

6.5.51

Visually inspect the door for traces of resin, cracks, or other damage. Clean the door with a
non-abrasive microfiber cloth and soapy water or a general purpose cleaner, such as glass
cleaner. In the case of a crack that allows light to pass through the door, install a new door.
Refer to section 8 Disassembly and repair for more information.

Inspecting the display

Visually inspect the display for any traces of resin. the display with a non-abrasive microfiber
cloth and general purpose cleaner, such as glass cleaner.

Inspecting the drip catcher

Visually inspect the drip catcher for any traces of resin. Clean the drip catcher with isopropyl
alcohol and low-fiber paper towels.

Moving parts. Disconnect the machine from its power source. Moving parts present
crushing and tangling hazards.

Skin irritant: Resin and solvent may cause skin irritation or an allergic skin reaction.
Wear gloves when handling liquid resin, resin-coated surfaces, or solvent. Wash skin
with plenty of soap and water.

Required supplies

« Isopropyl alcohol

+ Low-fiber paper towels

« Non-reactive nitrile gloves

To inspect and clean the drip catcher:

1. Put on a new, clean pair of nitrile gloves.

2. Disconnect the printer from its power source.

3. Remove the build platform, resin tank, and resin cartridge to access the drip catcher, which
is the area below the tank spout or under the cartridge dispense arm.

4. Visually inspect the drip catcher.

5. Clean any traces of resin or contamination with isopropyl alcohol and low-fiber paper towels.

Inspecting the shells

Visually inspect the rear, front and side shells for traces of resin or other damage. Clean any

traces of resin or contamination with soapy water and low-fiber paper towels.

Maintaining the Z-axis screw

The build platform mount rides along the Z-axis ball screw. The screw must be lubricated for

the build platform mount to move smoothly and quietly.

Moving parts. Disconnect the machine from its power source. Moving parts present
crushing and tangling hazards.

Inspecting the Z-axis screw

Visually inspect the Z-axis screw to ensure that the build platform mount moves smoothly and
that there is no debris built up in the screw threads.

Required supplies
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6.6

« Microfiber cloth or low-fiber paper towels

«+ Lithium grease for ball bearings

» Non-reactive nitrile gloves

To inspect the Z-axis screw:

1. Put on a new, clean pair of nitrile gloves.

2. Rotate the Z-axis screw. Depending on your printer’s firmware version, there is a maintenance
option, accessible through the printer’s touchscreen, that moves the build platform mount
along its screw. For detailed guidance and visual assistance, visit support.formlabs.com.

3. As the build platform mount moves up and down, listen, look, and feel to check for areas
that emit noise or where the build platform mount sticks or moves less smoothly.

4. Visually inspect the ball screw to ensure that no debris or foreign objects obstruct the ball
screw or path of motion.

5. Visually inspect the ball screw to ensure that lubricant covers the full length of the
screw threads.

6. Inthe case that the screw is missing lubricant or if the Z-axis emits intermittent noises when
printing, lubricate the ball screw using the instructions below.

Lubricating the Z-axis screw

To lubricate the Z-axis screw:

Put on a new, clean pair of nitrile gloves.

. Disconnect the printer from its power source.

. Remove the build platform and resin tank.

. Place a clean low-fiber paper towel over the LPU.

. Remove old and dirty grease from the screw using a paper towel.

. Apply a light layer of lithium grease specifically intended for use with ball bearings evenly

along the screw. Apply the lubricant directly from the container or by dabbing lubricant
onto the screw with a gloved hand.

o o~ w NS

7. Rotate the screw. Depending on your printer’s firmware version, there is a maintenance
option, accessible through the printer’'s touchscreen, that moves the build platform mount
along its screw. For detailed guidance and visual assistance, visit support.formlabs.com.

8. As the build platform mount moves up and down, listen, look, and feel to check for areas
that emit noise or where the build platform mount sticks or moves less smoothly.

9. Wipe the screw with a microfiber cloth or low-fiber paper towel to remove excess lubricant.

Planned maintenance

Perform the following maintenance tasks at the frequency specified in the table below. For
detailed guidance and visual assistance, visit support.formlabs.com.

Maintenance tasks shall be done according to the following plan:

Task Frequency Refer to Section
Updating the firmware When PreForm indicates a new Updating the 6.61
firmware version is available. firmware
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6.6.1

6.6.2

WARNING

Task Frequency Refer to Section
Filtering the resin When a cleaning sheet does not | Filtering the resin 6.6.2
sufficiently remove particles from
the resin tank.
Replacing the resin When the resin cartridge is Replacing the resin 6.6.3
cartridge empty, after 1liter of printing. cartridge
Cleaning the rear mesh When the printer indicates Cleaning the rear 6.6.4
filter that the rear mesh filter should mesh filter
be cleaned.
When the printer indicates
that the heater or resin has
exceeded its target temperature.
Cleaning the LPU When the LPU release texture is | Cleaning the LPU 6.6.5
release texture smudged or contaminated. release texture
Replacing the resin tank | When wear on the bottom of Replacing the resin 6.7.3
the resin tank begins to affect tank
print quality.
When the printer indicates that
the resin tank has reached the
end of its usable lifetime.
Lubricating the Z-axis Every 12 months, if the build Maintaining the Z-axis 6.5.5

screw

platform mount does not move
smoothly, or emit intermittent
noises when printing.

Updating the firmware

screw

Formlabs regularly releases updated firmware to fix bugs and improve functionality. Review
the PreForm and firmware release notes to learn more about the improvements that come with
each version’s release. For detailed guidance and visual assistance, visit support.formlabs.
com.

Filtering the resin

Filter resin to remove contamination and very small particulates of partially cured resin. For
detailed guidance and visual assistance, visit support.formlabs.com.

Skin irritant: Resin and solvent may cause skin irritation or an allergic skin reaction.
Wear gloves when handling liquid resin, resin-coated surfaces, or solvent. Wash skin
with plenty of soap and water.

Required supplies

« Non-reactive nitrile gloves

»  Opaque container suitable for storing resin

- Paint or oil filters (“fine” or 190 micron mesh size)
To filter the resin:
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6.6.3

O

NOTICE

6.6.4

6.6.5

1. Put on a new, clean pair of nitrile gloves.

N

. Suspend the paint or oil filter (with a “fine” or 190 micron mesh size) above an opaque
container suitable for storing resin. Use a ring stand to reduce the risk of spilling resin.

. Remove the resin tank and mixer. Place the mixer aside on a protected surface.

. Hold the edge of the resin tank, taking care not to touch the resin tank’s underside.

. Tilt the resin tank with the tank spout aligned directly above the filter.

. Pour the resin through the filter, into the opaque plastic container.
Gently scrape the interior of the resin tank with the plastic tank scraper to pull resin toward
the tank spout.

8. Once all resin passes through the filter, pour the resin back into the resin tank.

9. To dispose of the used filter, refer to section 9.1 Disposal of resin and accessories.

Replacing the resin cartridges
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Replace the resin cartridges to change materials between prints or when a resin cartridge

is empty.

To replace a resin cartridge:

1. Press the vent cap closed.

2. Hold the resin cartridge by its handles.

3. Lift the resin cartridge out of the printer.

4. Store or dispose of the resin cartridge. For detailed guidance and visual assistance, visit
support.formlabs.com.

5. To install a new resin cartridge, refer to section 410 Inserting the resin cartridges.

Store the resin cartridges upright with the valve covers installed to protect storage
surfaces from resin.

Cleaning the mesh filter
The mesh filter is located on the right side of the printer, underneath the resin cartridge slots.
It magnetically attaches to the printer and covers the LPU air intake. A clean dust filter ensures
that the LPU and resin do not overheat. For detailed guidance and visual assistance, visit
support.formlabs.com.
Required supplies
« Vacuum
To clean the rear mesh filter:
1. If necessary, move the printer to be able to access the right side of the machine.
2. Locate the mesh filter.
3. Remove the mesh filter from the printer.
4. Vacuum the mesh filter until it is clean and free from dust or debris.

a. If the mesh filter cannot be cleaned, replace it.
5. Reattach the mesh filter to the printer, ensuring that it is aligned with the air intake vents.
Cleaning the LPU release texture
The texture on the top of the LPU reduces forces on the printed parts, resin tank, and printer
between layers. Maintain a clean LPU to prevent print failures and damage to the resin tank.
For detailed guidance and visual assistance, visit support.formlabs.com.
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6.71

Skin irritant: Resin and solvent may cause skin irritation or an allergic skin reaction.
Wear gloves when handling liquid resin, resin-coated surfaces, or solvent. Wash skin
with plenty of soap and water.

Required supplies

» Isopropyl alcohol

« Non-reactive nitrile gloves

« Non-abrasive wipes

+ Rubber bulb air blower

To clean the release texture:

1. Put on a new, clean pair of nitrile gloves.

2. Grip the top of a non-abrasive wipe with a gloved hand. Soak the bottom half of the wipe
with clean isopropyl alcohol.

3. Dragtheisopropyl alcohol soaked wipe slowly across the surface of the LPU. It should take
20-30 seconds to traverse the width of the LPU.
o Do not contact the release texture with your hand or apply pressure to the wipe.
o For debris and resin near the edge of the LPU, always drag the wipe towards the edge

of the LPU to avoid spreading the contaminant.
4. Wait for the isopropyl alcohol on the release texture to dry.
5. Repeat this process several times until the contaminant has been removed.

Maintaining the resin tank

The resin tank is the primary container for holding resin after it is dispensed from the resin
cartridge. Resin is cured onto the build platform when the light from the backlight passes
through the bottom of the resin tank. Be sure to handle and maintain the resin tank properly
between each print. For detailed guidance and visual assistance, visit support.formlabs.com.

Skin irritant: Resin and solvent may cause skin irritation or an allergic skin reaction.
Wear gloves when handling liquid resin, resin-coated surfaces, or solvent. Wash skin
with plenty of soap and water.

Spill hazard: Resin may spill over the tank walls if the resin tank tilts more than 5-10
degrees. Hold the resin tank level with two hands. To inspect and clean the resin
tank’s underside, empty the resin tank and/or take care to avoid spilling resin outside
the resin tank.

Sharp and metal tools can damage the resin tank and affect print quality, leading to
print failures and/or a resin spill. Do not use sharp or metal tools like the removal tool
or flush cutters to inspect or clean the resin tank.

Inspecting the resin tank

For the best results, inspect resin tanks regularly and, if necessary, clean them. Dirty optical
surfaces and damage to the resin tank may cause print failures.
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Required supplies
« Non-reactive nitrile gloves
» Plastic tank scraper
To inspect the resin tank interior:
1. Put on a new, clean pair of nitrile gloves.
2. Use the plastic tank scraper to inspect the resin and the resin tank interior. Refer to section
7.3 Cleaning after a failed print, steps 1-3.
3. Check for the following issues that may lead to print failures or any excessive wear that
requires switching to a new resin tank:
o Cured resin on the bottom of the tank
o Debris or failed prints in the resin
o Cuts or gouges in the bottom of the tank
4. If necessary, follow cleaning instructions to remove cured resin, failed prints, debris, and
settled pigment in the resin tank.
o For moderate wear or scratches on the bottom of the tank, use the Layout tool in PreForm
to move the model outside the worn or scratched area.
o In the case of excessive wear or scratches on the bottom of the tank, switch to a new
resin tank. Refer to section 6.7.3 Replacing the resin tank.

To inspect the resin tank exterior:

1. Put on a new, clean pair of nitrile gloves.

2. Visually inspect the resin tank exterior for fingerprints, dust, contamination, and scratches,
which cause the light from the backlight to diffuse and lead to print failures or inaccuracies.

3. If necessary, use the cleaning instructions to remove any fingerprints, dust, or contamination
on the bottom of the resin tank.

o For moderate wear or scratches on the bottom of the resin tank, use the Layout tool in
PreForm to move the model outside the worn or scratched area.

o In the case of excessive wear or scratches on the bottom of the resin tank, switch to a
new resin tank. Refer to section 6.7.3 Replacing the resin tank.

To inspect the tank frame:

4. Put on a new, clean pair of nitrile gloves.

5. Visually inspect the tank frame for contamination or resin. Resin on the tank frame may result
in print failures and/or damage to the release texture. If the release texture is contaminated,
refer to section 6.6.5 Cleaning the release texture.

Cleaning the resin tank

Keep the resin tank clean and free of cured resin and other debris to ensure print quality and

extend the lifetime of the printer.
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6.7.3

Required supplies

Resin tank interior Resin tank exterior Tank frame

» Cleaning sheet « Isopropyl alcohol » Low-fiber paper towels

» Non-reactive nitrile gloves  « Non-reactive nitrile gloves « Non-reactive nitrile gloves
- Plastic tank scraper » Disposable non-abrasive

« Isopropyl alcohol lint-free wipes

» Disposable non-abrasive
lint-free wipes

To clean the resin tank interior:
«  Print failures:

o Refer to section 7.3 Cleaning after a failed print.

o Clean the resin tank interior using a cleaning sheet or manually with the plastic
tank scraper.

» Debris or contamination in the resin:

o Refer to section 6.6.2 Filtering the resin.

o Clean, debris-free resin helps avoid print failures, which may damage the resin tank.
« Settled pigment in the resin:

o Resin pigment can settle onto the interior of the resin tank. To supplement the mixer’s
function, slide the plastic tank scraper against the bottom of the resin tank to remove
settled pigment.

To clean the resin tank exterior:
1. Put on a new, clean pair of nitrile gloves.
2. Empty the liquid resin from the resin tank into an opaque container.
3. Apply a small amount of clean isopropyl alcohol to a disposable non-abrasive lint-free wipes.
4. Wipe the resin tank exterior to remove contamination or resin.
To clean the tank frame:
1. Put on a new, clean pair of nitrile gloves.
2. Wipe the tank frame with a low-fiber paper towel to remove contamination or resin.
Replacing the resin tank
Replace the resin tank to change materials between prints or when a resin tank is damaged
or needs to be cleaned.
To replace the resin tank:
Put on a new, clean pair of nitrile gloves.
. Remove the build platform from the printer.
. Unlatch and remove the mixer.
. Unlatch the resin tank latches.
. Hold the side walls of the resin tank.
. Pull the resin tank out of the printer.

Place the lid on the resin tank.

. To install a new resin tank, refer to section 4.8 Inserting the resin tank and mixer.
To dispose of the old resin tank, refer to section 9.1 Disposal of resin and accessories.
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7.3

WARNING

NOTICE

Troubleshooting

Collecting diagnostic logs

The Form 4BL maintains diagnostic logs to provide detailed information about the machine
that may expedite issue investigation. After experiencing any error or unusual behavior on
the Form 4BL, include the diagnostic logs with other relevant observations and details when
contacting Formlabs Support or a certified service provider. The options for sharing diagnostic
logs vary depending on the machine’s connection type. For detailed guidance and visual
assistance, visit support.formlabs.com.

Performing a factory reset

On some occasions, a factory reset may correct unusual printer behavior. Unusual behavior
may include unknown error messages, incomplete firmware updates, an unresponsive
touchscreen, or trouble connecting to PreForm. For detailed guidance and visual assistance,
visit support.formlabs.com.

Do not perform a factory reset immediately before contacting Formlabs Support

or a certified service provider. The stored diagnostic information may be helpful to
Formlabs Support or a certified service provider to assist with troubleshooting. A
factory reset erases diagnostic information and custom settings, including uploaded
print jobs and networked connections.

Cleaning after a failed print

Occasionally, a print may fail to complete. A failed print may leave small, partially-cured pieces
of resin floating in the resin tank or hard cured resin stuck to the interior of the resin tank.
Inspect the resin tank after every print. Remove debris after a failed print. For detailed guidance
and visual assistance, visit support.formlabs.com.

Skin irritant: Resin and solvent may cause skin irritation or an allergic skin reaction.
Wear gloves when handling liquid resin, resin-coated surfaces, or solvent. Wash skin
with plenty of soap and water.

Sharp and metal tools can damage the resin tank and affect print quality, leading to
print failures and/or a resin spill. Do not use sharp or metal tools like the removal tool
or flush cutters to inspect or clean the resin tank.
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7.31

7.3.2

7.3.1 Removing cured resin with the cleaning sheet
Formlabs Low Force Display (LFD)" printers can print a cleaning sheet, which is a thin, flat
printed part that binds loose debris together. The cleaning sheet adheres to the resin tank for
removal using the plastic tank scraper. Print a cleaning sheet after a failed print to more easily
remove cured resin and other debris.
Required supplies
+ Non-reactive nitrile gloves
« Paper towels
« Plastic tank scraper
To remove cured resin with the cleaning sheet:
1. Put on a new, clean pair of nitrile gloves.
. Tap the wrench icon on the Home screen. The Maintenance menu appears.
. Tap Cleaning Sheet. The Print Cleaning Sheet screen appears.
. Tap Clean. The cleaning sheet begins printing.
. Once the cleaning sheet is complete:

a. Remove the build platform and resin cartridge from the printer.

b. Remove the mixer and resin tank from the printer. Place the resin tank on a clean,

flat surface.
6. Prepare several paper towels nearby to collect cured and uncured resin.
7. To remove the cleaning sheet:
a. Slide the edge of the plastic tank scraper under the edge of the cleaning sheet.
b. Pry with moderate pressure. Slide or pry from different angles or increase pressure to
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detach the cleaning sheet from the resin tank. Do not press directly into the resin tank
with the edge of the tank scraper.
c. Lift the cleaning sheet out of the resin tank.
d. Rest the cleaning sheet on paper towels.
8. To dispose of the cleaning sheet, refer to section 9.1 Disposal of resin and accessories.
9. Clean the plastic tank scraper and work surface.
Removing cured resin manually
The Form 4BL comes with a plastic tank scraper, which can be used to remove cured resin
from the interior of the resin tank without damaging it. Remove individual pieces of cured resin
from the resin tank with the plastic tank scraper.
Required supplies
« Non-reactive nitrile gloves
« Paper towels
« Plastic tank scraper
To manually remove cured resin:
1. Put on a new, clean pair of nitrile gloves.
. Remove the build platform and resin cartridge from the printer.
. Remove the mixer and resin tank from the printer. Place the resin tank on a clean, flat surface.
. Prepare several paper towels nearby to collect cured and uncured resin.
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. Rest the edge of the plastic tank scraper on the interior of the resin tank. Skim the surface.
Search for obstructions that indicate cured resin stuck to the resin tank.
6. To remove cured resin:
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a. Slide the edge of the plastic tank scraper under the edge of the cured resin.

b. Pry with moderate pressure. Slide or pry from different angles or increase pressure to
detach the cleaning sheet from the resin tank. Do not press directly into the resin tank
with the edge of the tank scraper.

c. Lift the cured resin out of the resin tank.

d. Rest the cured resin on paper towels.

7. To dispose of cured resin, refer to section 9.1 Disposal of resin and accessories.
8. Clean the plastic tank scraper and work surface.
733 Cleaning the plastic tank scraper
Clean the plastic tank scraper after each use to remove excess liquid resin and
prevent contamination.

Required supplies

Wiping Washing

+ Isopropyl alcohol « Form Wash or Form 4BL Finish Kit
+ Low-fiber paper towels « Isopropyl alcohol

+ Non-reactive nitrile gloves + Non-reactive nitrile gloves

To wipe the plastic tank scraper:

1. Put on a new, clean pair of nitrile gloves.

2. Apply clean isopropyl alcohol to a clean low-fiber paper towel.

3. Wipe the surface of the plastic tank scraper to remove resin.

4. Allow the plastic tank scraper to air dry after wiping.

To wash the plastic tank scraper:

5. Put on a new, clean pair of nitrile gloves.

6. Rest the plastic tank scraper in the wash basket of the Form Wash or rinse bucket of the
Form 4BL Finish Kit.

7. Washthe plastic tank scraper for five minutes. Increase the wash time for heavily-used solvent.

8. Allow the plastic tank scraper to air dry after washing.

7.4 Troubleshooting errors or abnormal activity
In the case of errors, abnormal activity, or print failures with the Form 4BL, reference the
following errors, causes, and proposed solutions. Complete the initial troubleshooting steps
and carefully document all results. For detailed guidance and visual assistance, visit support.
formlabs.com.

7.41 Resolving abnormal functions during print setup
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7.4.2

Error

The bite valve does not
dispense resin.

The orange Upload
Print icon is not
available in PreForm.

Error messages

Error 6.3: Cartridge
missing

Error 6.8 or Error
6.9: Tank missing

Cause

- The silicone material
has sealed itself.

« Resin may cure
over the bite
valve opening.

The printer may not be
properly connected to
the same LAN.

The printer cannot
sense the inserted
resin tank and/

or cartridge.

Resolving print failures and errors
Print failures can manifest in different ways and originate from different causes. Check the model
configuration in PreForm, the cleanliness of the optical surfaces, and the machine’s operating
condition according to section 6 Maintenance, including the proposed solutions below.

If print failures persist after following these steps, contact Formlabs Support or a certified

Solution

1.

2.

w
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Press the vent cap closed and remove the resin
cartridge from the printer.

Turn the cartridge upside down to inspect the
bite valve.

Squeeze the bite valve a few times to open up
the seal and enable resin flow.

If squeezing the bite valve does not enable resin
flow, carefully use the tip of a pair of tweezers to
push through the opening to enable resin flow.

. If the bite valve seal remains closed after

troubleshooting, contact Formlabs Support or
a certified service provider for additional help.
Submit photos of the bite valve seal with

your request.

Check for other open instances of PreForm.
Save any files before restarting PreForm.
Disconnect your printer from the LAN and
reconnect to establish a proper connection.

Fully remove the resin tank and/or cartridge.
Reinsert the resin tank and/or cartridge.

service provider for additional guidance. In order to introduce a known good variable to

isolate any printing issues, run a Formlabs test print, for which the file is available on support.

formlabs.com. Provide clear, focused photographs of the test print to help diagnose the issue.

Error

Delamination

« Peeling or separation
between printed
layers

OR

« Pieces of cured parts
float in the resin tank

Cause

- Model orientation, layout,

and/or support issues

- Aprint that has been paused | -

for along time
« An older resin tank
« Aloose build platform
- Contaminated optical
surfaces

Solution

- Check the model in PreForm

Check for pauses in printing

Check the resin tank for debris or
damage

Check the cleanliness of optical
surfaces

- Check the stability of the build platform
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Error

Non-adherence

- Prints partially
attached to the build
platform

OR

« Prints completely
non-existent on the
build platform

Overcompression
The base printed onto
the build platform is
thinner than expected
and/or very difficult

to remove.

Poor surface finish

« Cured or partially
cured resin forms
thin, shelf-like
structures that hang
horizontally from a
print

OR

« Arough, uneven,
or bumpy surface
texture forms on one
or both sides of an
otherwise successful
print

Undeveloped feature
A void of missing
material forms within a
print and widens as the
print builds away from
the build platform.

46

Cause

Printing without supports

The first layer of the part on
the build platform is too small
to withstand peel forces

« Debris/damage in resin tank
« Contaminated optical
surfaces

Build platform height requires
adjustment

The initial layers fail to cure
properly, due to insufficient
space between the build

platform and the resin tank.

Diffused light spreads the cure

area beyond the appropriate

limits for each layer outline,

due to:

- Expired resin

- Debris/damage in the resin
tank

« Contaminated optical

surfaces

Restricted resin flow due to

improper model orientation or

overly dense supports

- Debris/damage in resin tank

- Model orientation, layout,
and/or support issue

« Contaminated optical
surfaces

Solution

« Print with a base and supports
Check that the first layer’s surface area
is sufficiently large

Check the resin tank for debris or
damage

Check the cleanliness of optical
surfaces

Check the build platform height
Use the Align Build Platform
calibration tool on the touchscreen
to adjust the parallelism of the build
platform. Tap Settings > Tools >
Align Build Platform and follow the
on-screen instructions.

Increase the base height in PreForm’s
advanced settings

Check the build platform height

Use the Align Build Platform
calibration tool on the touchscreen

to adjust the parallelism of the build
platform. Tap Settings > Tools >
Align Build Platform and follow the
on-screen instructions.

Check the resin’s shelf life

Check the resin tank for debris or
damage

Check the cleanliness of optical
surfaces

Check for restricted resin flow

Check the resin tank for debris or
damage

Check the model in PreForm

Check the cleanliness of optical
surfaces

Check the function of the Backlight
Unit and LPU. Tap Settings > Tools

> Inspect optics and follow the
on-screen instructions. A properly-
functioning Backlight Unit and LPU will
be uniformly lit or uniformly dark during
the test.



Error

Holes or lines
Models have linear cuts
or holes.

Cause

Obstructions in the optical

path block the backlight from
curing resin in a specific part of
the model.

Solution

- Check the resin tank’s underside for

debris o

r damage

« Check the cleanliness of optical

surfaces
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8.

A

WARNING

Disassembly and repair

All steps that involve opening the machine and/or investigating internal components
should be done by skilled persons under the guidance of Formlabs Support or a
certified service provider.

Contact Formlabs Support or a certified service provider to receive repair instructions and
authorization, including how to disassemble or remove the shells.

Task Frequency

Replacing the Light Processing unit

When the LPU has visible damage or defects.
When the LPU no longer masks the light from
the Backlight Unit correctly.

When advised by Formlabs Support or a
certified service provider.

Replacing the Backlight Unit

When the backlight has visible bright or
dark spots.

When advised by Formlabs Support or a
certified service provider.

Replacing the touchscreen When the touchscreen becomes inoperable or
does not respond to touch inputs.

Replacing the door When advised by Formlabs Support or a certified
service provider.
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A

WARNING

911

JA

CAUTION

91.2

913

914

Recycling and disposal
Disposal of resin and accessories

Skin irritant: Resin and solvent may cause skin irritation or an allergic skin reaction.
Wear gloves when handling liquid resin, resin-coated surfaces, or solvent. Wash skin
with plenty of soap and water.

Liquid resin
To dispose of pure resin (resin that has not been cured or dissolved in solvent), add this waste
to your chemical waste stream.

Environmental hazard: Refer to the safety data sheet (SDS) and local authorities

for guidance on disposing of resin and solvent. Liquid resin (whether pure liquid,
dissolved in solvent, or partially cured) may be classified as hazardous waste in your
region and shall be disposed of with care.

If you do not have a chemical waste stream:

1. Put on a new, clean pair of nitrile gloves.

2. Pour a small amount of resin into a labeled container suitable for storing resin.

3. Leave the container outside, exposed to sunlight to cure for 1-10 days. Expose resin to
405 nm light and heat for the most effective curing. The liquid resin cures to solid material
when exposed to light and heat.

4. Dispose of the fully cured resin and container in the household waste.

Cured resin or cleaned prints

Dispose of cleaned prints and cured (hardened) resin in the household waste. Cleaned prints

and cured resin cannot be recycled.

Empty resin cartridges

In the United States, empty resin cartridges are considered RCRA empty by EPA standards

and can be disposed of as household waste. Regulations that control waste are often regional

and vary by jurisdiction. Check with applicable local agencies to ensure that you are disposing
of empty resin cartridges properly.

OPTIONAL: Triple rinse resin cartridges with clean solvent to remove traces of excess resin

from the resin cartridge interior. Add the resulting used solvent to your chemical waste stream

in accordance with all applicable regulations.

Resin tanks

Dispose of a resin tank when it is damaged, has reached the end of its lifetime, or is otherwise

unsuitable for use.

To dispose of a resin tank:

1. Put on a new, clean pair of nitrile gloves.

2. Remove the build platform from the printer.

3. Lift the lever securing the mixer.

4. Remove the mixer from the mixer mount and set it aside.
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O

NOTICE

9.2

9.3

. Open the two latch handles securing the resin tank in the printer.
. Lift the resin tank out of the printer.

N o o

Transfer or dispose of the remaining resin.

» Pour the resin from the old resin tank to a new resin tank or another container.

- If there is debris or cured parts in the resin, filter the resin before transferring it to a new
resin tank. Refer to section 6.6.2 Filtering the resin for more information.

Pouring resin back into the original resin cartridge may risk contaminating the resin
cartridge with cured resin pieces or debris, which can cause print failures.

8. Use a paper towel to wipe any remaining resin off the old resin tank.
9. Place the old resin tank in sunlight (a window sill is fine) or UV light to cure excess resin,
and dispose of properly once cured.

Disposal of solvent

Safe and appropriate disposal methods of used solvent vary by location.

To safely dispose of used solvent:

1. Consult the safety data sheet (SDS) from the solvent supplier as the primary source
of information.

2. Research the approved methods of disposal for your area. This will most likely involve hiring
a waste disposal service. For smaller amounts, check with a hazardous disposal service to
see if they have any suggestions for removal.

3. Inform your waste disposal service that your bottle contains solvent with small amounts of
methacrylated monomers and oligomers (unpolymerized plastic resin) and trace amounts
of photoinitiator. Have a copy of the Formlabs resin safety data sheet (SDS) on hand in case
the disposal service attendant needs more information.

Recycling of solvent

For large volumes of solvent, consider using a solvent recycling system, which offers a

cost-effective and more environmentally responsible alternative to paying for waste solvent

disposal services. Solvent recycling systems use distillation and fractionation processes to
remove solutes from waste solvents, making it possible to reuse the solvent to wash prints.

The recycled solvent may still have small amounts of monomers in it. Recycling solvent

reduces waste disposal costs, emissions that are required to produce solvents, and the cost

of purchasing solvent.

Disposal of electronic components

The symbol on the product, the accessories, or packaging indicates that this device shall
not be treated as nor disposed of with household waste. When you decide to dispose of
this product, do so in accordance with environmental laws and guidelines. Dispose of the
device via a collection point for the recycling of waste electrical and electronic equipment.
By disposing of the device in the proper manner, you help to avoid possible hazards for the
environment and public health that could otherwise be caused by improper treatment of waste
equipment. The recycling of materials contributes to the conservation of natural resources.
Therefore do not dispose of your old electrical and electronic equipment with the unsorted
municipal waste.
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9.4 Disposal of packaging waste
The packaging is made of cardboard and plastic-based materials. Dispose of packaging
through waste and recycling facilities. By disposing of the packaging waste in the proper
manner, you help avoid possible hazards for the environment and public health.

@ Save the Form 4BL’s packaging including any inserts for transporting the machine.
NOTIeE Original packaging is required for warranty service and designed to be kept and
reused for transportation or shipping.
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1.

Glossary

Term

Backlight Unit

Bite valve

Build platform

Build platform mount

Build platform jig

Build platform latch

Build platform sensor

Cartridge dispense arm

Cartridge RFID sticker
Cleaning sheet

Door

Display assembly
Display cable
Display PCB

Ethernet port

Fans

54

Meaning

A set of 405 nm LEDs emit light upwards through lenses, the
Light Processing Unit, and the bottom of the resin tank to cure
liquid resin.

A flexible, rubber seal that regulates resin dispensing. Resin
flows out when the cartridge dispense arm squeezes the bite
valve open.

The aluminum base provides a surface for prints to attach to. Over
time, the build platform develops scratches from part removal,
which can assist with print adherence.

The metal arm that the build platform slides onto.

Stabilize the build platform for the secure removal of prints.
Secure the build platform jig to the edge of your work surface by
tightening the jig screw clamps underneath the work surface.

A lever that is part of the locking mechanism that secures the build
platform. Contact Formlabs Support or a certified service provider
before adjusting the platform lock, as improper adjustment can
damage the machine.

Each Form 4BL build platform has an RFID sticker. The printer
senses the RFID sticker to detect when the build platform is
properly installed.

Plastic hooks press against the bite valve to dispense resin out of
the resin cartridge into the resin tank.

Each resin cartridge has an RFID sticker attached to the cartridge
skirt. The printer reads the RFID sticker to detect the unique
cartridge ID and resin type.

A thin, flat printed part that binds loose resin and other debris
together in the resin tank for removal and disposal.

The printer lid, made of a strong, orange-tinted material, blocks
exposure to the curing light and protects the resin from curing due
to ambient light.

The display assembly contains the touchscreen and the display
circuit board. A ribbon cable connects the display assembly to
the motherboard.

A flat, flexible cable connects the display assembly to
the motherboard.

This circuit board, separated from the main motherboard, controls
the touchscreen.

The Form 4BL can connect to a network via Ethernet. The port
is connected to the motherboard and can be accessed from the
back of the machine.

Cooling fans pull warm air away from electronic components: the
backlight, the LCD, and the power supply



Term

Flush cutters

Heater

Interlock magnets

Leveling disc

Leveling feet

LevelSense

Low Force Display (LFD)™ Print
Engine

Light Processing Unit (LPU)

LPU release texture

Mixer

Motherboard

Non-abrasive lint-free wipes

Plastic tank scraper

Power supply

Removal tool

Resin cartridge

Resin tank

Meaning

Snip to separate prints from their supports. Cut with the flat side
on the prints’ surface for minimal support marks.

The resin in the resin tank is heated by resistive heaters located
below the resin tank.

The interlock sensor detects these magnets to determine when
the door is closed. This safety mechanism triggers the Door Open
message on the touchscreen and disables the backlight when the
door is open.

Slide the leveling disc included around one of the leveling feet
and rotate to raise or lower the printer.

Each corner of the printer is supported by a rubber foot that is
threaded into the bottom of the machine. When prompted by the
touchscreen, use the leveling disc to raise or lower each foot to
ensure that the printer is acceptably level.

An ultrasonic sensor, located above the rear left-hand corner of
the resin tank detects the amount of resin in the resin tank.

An advanced form of stereolithography (SLA) to cure solid
isotropic parts from liquid resin.

The LPU blocks the 405 nm light from the backlight to selectively
expose and cure each layer of a print.

The texture on the top of the LPU reduces forces on the printed
parts, resin tank, and printer between layers.

The mixer improves print consistency by clearing the build area
and circulating the resin. The mixer moves via a belt that runs
across the front of the printer.

The main circuitry through which all systems in the
printer communicate.

Disposable lint-free, non-woven microfiber cloths for cleaning
the printer’s optical components. Do not reuse a cleaning wipe;
dispose of after each use.

Use the plastic tank scraper to inspect the resin tank and remove
cured resin from the tank film.

The Form 4BL utilizes a 100-240 VAC power supply. The internal
power supply converts line power to DC power for the printer.

Pry under the raft to remove prints from the build platform.

A container that holds the resin before dispensing into the resin
tank. Shake resin cartridges periodically to keep resin well mixed.

Resin is dispensed out of the resin cartridge into the resin tank.
During a print, light passes upwards through the bottom of the
resin tank and cures resin onto the build platform to form a printed
part. Only use approved materials and procedures to clean the
resin tank.
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Term

Resin tank RFID sticker

Rinse basket

Rinse bottle

Rinse bucket

Shell

Solvent pump

Status light

Tank carrier

Tank lid

Tank handles

Tank spout

Touchscreen

USB port

Vent cap

Wi-Fi antenna
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Meaning

Each resin tank has an RFID sticker attached to the back wall of
the tank frame. The printer reads the RFID sticker to detect the
unique tank ID and current resin type.

Place prints in the rinse basket, place the rinse basket into the
rinse bucket, and agitate to clean.

Remove resin trapped in cavities and internal channels of prints.
Use clean solvent. Formlabs recommends isopropyl alcohol.

Fill the rinse bucket with solvent before washing prints. The
rinse bucket includes a ground wire to prevent static discharge.
Formlabs recommends isopropyl alcohol, tripropylene glycol
monomethyl ether, or Formlabs Resin Washing Solution.

Five protective external casings protect the printer’s

internal components:

Right shell: metal casing for the right side of the printer

Left shell: metal casing for the left side of the printer.

Rear shell: metal casing for the back face of the printer.

Door: printer lid, made of an orange-tinted material; hinged to the
left of the printer.

Front shell: metal casing that covers the bottom of the front face of
the printer (below the door).

Fill and empty the rinse bucket.

Two interior lights (vertical strips along the left and right walls)
and an illuminated logo (on the front panel) that pulse to indicate
the printer is active, a print has completed, or the printer has
encountered an error.

The tank carrier holds the resin tank in place during printing.

Each resin tank includes a lid for storing and protecting the resin
tank when notin use.

Handles on each side of the resin tank allow for easy insertion,
removal, and carrying of the resin tank. Use the tank handles to
avoid touching the resin tank’s underside, as fingerprints leave
smudges that obstruct the optical path.

A spout at the right of the resin tank sits underneath the cartridge
dispense hole and receives resin from the resin cartridge.

The LCD capacitive touch user interface displays print information,
settings, and error messages.

The Form 4BL can connect to a computer via USB. The port is
connected to the motherboard and can be accessed from the
back of the machine.

The lid at the top of the cartridge allows for air interchange,
enabling proper resin dispensing. Press the vent cap open prior
to printing.

The external Wi-Fi antenna enables the Form 4BL's
wireless connectivity.



Term Meaning

Z-axis ball screw The Z-axis ball screw is a threaded rod that controls the vertical
motion of the build platform mount.

Z-tower This vertical tower at the back of the machine provides support for
many components of the Form 4BL. The build platform is raised
and lowered along the Z-axis, inside the Z-tower.
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12.

Product compliance

The Form 4BL complies with the following electrical and photobiological safety standards:

Electrical

UL 62368-1:2019 Ed.3+R:220¢t2021
CSA C22.2#62368-1:2019 Ed.3+U1
IEC 62368-1:2018

EN IEC 62368-1:2020+A11:2020
AS/NZS 62368.1:2022
J62368-1(2023)

Machinery

EN 60204-1:2018

Photobiological

IEC 62471:2006

Intertek Control Number: 5029059
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